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Screencasting with Camtasia Studio 

What is a Screencast? 
While a screenshot is a still picture of a computer screen, a screencast is a recording of a screen over 
time, often with accompanying narration, that is distributed, typically, online. Screencasts are popular for 
capturing PowerPoint presentations, creating tutorials on how to use software, and for demonstrating 
how to locate resources on the Web.  

Camtasia Studio is one of several tools for creating screencasts available for Microsoft Windows. Other 
options include Adobe Captivate ($$$) and Techsmith’s Jing (free, and similar to Camtasia Recorder, but 
with a 5 minute limit per video). You can download a full-featured 30-day trial version of Camtasia 
Studio from www.techsmith.com. UMass Amherst does not provide university-wide licensing for this 
product. 

Instructors can either record “live” in a classroom, or in the privacy of their office, or, are welcome to 
reserve our recording room and laptop for recording or editing.  

What Do I Need to Create a Screencast?  
Camtasia Studio provides the software for recording, editing and publishing screencasts.   

In addition to Camtasia you will need 

• A microphone to record narration.  

• A webcam to record video of the narrator/presenter that can appear in a corner of the screencast 
window. 

• A way to share your screencast movie, such as a Moodle course, a Google account, a blog, or 
another sort of Web site. 

Screencasting is sometimes combined with “inking” technology, for instance using a Tablet PC, to 
annotate PowerPoint or OneNote slides. With the right apps installed, you can record from a phone or 
tablet. 

Two Ways to Create Screencasts in Camtasia Studio 
Camtasia Studio provides two primary methods for recording screencasts; you can record any area of the 
screen and any activity that takes place in that area, or you can record within PowerPoint. 

Screen recording 
The Record all activity on the screen, or a selected area of the screen. Record within a single application 
window, or across any software in use.  

This is the preferred method for creating screencasts of most computer activities such as software 
demonstration or guide to finding resources on a website.  

PowerPoint Add-in 
Camtasia Studio includes a PowerPoint Add-in that facilitates creating screencasts of PowerPoint 
presentations. This is the preferred method for capturing screencasts of PowerPoint presentations, as long 
as the presentation does not include links that take you out of PowerPoint, for instance, if your 
presentation has a link that opens a web page in a web browser.  
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Process Overview 
 There are three distinct steps to creating a screencast in Camtasia, with different file types for each step. 

1. Record 
     The first step is to create your recording in Camtasia.   
     This creates a .trec  file.  

2. Edit 
The .trec file is edited in Camtasia Studio in a new project.  
The project file is saved in the editable .camproj format.       
 

3. Produce & Share 
You can’t post a .cmrec or .cmproj file on the Web. They only work in Camtasia. Before you share 
your screencast, it must be exported to a file format your audience can play in a standard video player, 
for instance, in a Web browser or by downloading to play.  

If you publish to a Google Drive, YouTube, orScreencast.com (Techsmith’s hosting service), 
Camtasia will not save local files, but will upload video directly to the hosting service. 

To host your screencast on Moodle or UDrive, produce as MP4 – with smart player, and be sure to 
upload all the files to your site, then link to the .html file.   

Note: Files created in Camtasia Studio for Windows and Camtasia Mac are not completely 
interchangeable. The recording files (.trec) can be used in the Camtasia Editors on both Windows and 
Mac, but Windows .camproj files cannot be edited on the Mac, and Mac .cmprj files can’t be edited in 
Camtasia Studio for Windows. 

Before you Start  

Prepare your narration 
It is useful to have an outline or notes to work from when recording narration for a screencast. 
Depending on your needs and personal style, a well-organized outline may be as useful as a detailed 
script in ensuring that you cover the relevant material and still sound natural and engaging.    

Set up your computer screen and recording environment 
Do you need to record the entire computer screen, including application menus, or just the inside of a 
document window or browser window?  Will your computer’s desktop show in the demo?  Do you need 
to clean it up?  

Are you recording a software or Web site demo?  If so, avoid custom settings or add-ons in your 
application or browser that your audience may not have on their own computers.    

Don’t forget to silence your cell phone, close the door if you are recording in your office,  turn off fans 
or other background noise. 

Check your recording hardware 
There’s nothing worse than going to start your lecture only to discover your audio/video hardware is not 
connected. 

• Make sure your microphone is plugged in to your computer. 

• If you will record video, make sure your camera is plugged in to your computer. 
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Record an Area of the Screen with the Camtasia Recorder 
Set up the recording 

1. Arrange the open application windows to show what will be onscreen at the beginning of your 
recording. 

2. Launch Camtasia Studio. The first time Camtasia Studio opens, a Getting Started project 
appears. 
Go to File > New Project to close the Getting Started project and begin a new one. You do not 
want to record into the Getting Started demonstration project! After the first time you use 
Camtasia, only the Welcome Screen will open. 

3.  On the Welcome Screen, or, if Camtasia is already open, in the Camtasia Studio Task Bar  
(at top), click Record the Screen,. 
  
  
  

The Welcome Screen provides an easy way to get started with the 
different ways of creating screencasts, such as recording the 
screen, or importing images for a slide show (Import Media).  

  
  
  
  
  
  
  
  
 
The Camtasia Recorder panel will open.  

4. On the Camtasia Recorder panel: 

a.  Set the area to record:  
To record the entire screen, click Full Screen.  
To record a selected are of the screen use the Dimensions pop-out to choose a preset 
size, either Wide Screen or Standard aspect ratio (proportions).                      
 
Tip: This step sets the  
dimensions for the  
recording area. Later,  
after you finish recording,  
you can reduce the dimensions.  
 
Recording at larger dimensions  
than you will produce the final  
video will allow you to use Camtasia’s  
zooming features to zoom in and make  
details easier to see (e.g., record at  
1024 x 768, then produce at 640 x 480). 
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b. Arrange the windows or capture area: 
Because you are not recording yet, you can still fine-tune the capture area: 

     -  Rearrange the windows on the screen to fit inside the capture area. 
     -  Relocate the capture area by dragging the crosshairs at its center. 
     -  Enlarge or reduce the capture area by dragging a handle at its edge.   

c. Select and adjust video input devices: 
Choose whether to include camera video in your recording by clicking the Webcam 
button to toggle video on and off the camera (by default, camera input is set to off).   
 
Use the camera pop-out menu to select the video source (for example, a built in 
Webcam, or a camera you have attached to your computer to record).   
 
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
 

d. Select audio input: 
To choose whether to record narration along with the screen, click the Audio button to 
toggle on and off any mic connected to your computer (by default, audio is set to on.) 
 
Use the audio pop-out menu to select your audio source.  A portable mic or headset may 
not be automatically recognized by your computer. You may need to select one from the 
audio menu. 
 
  
 
 
 
 
 
 
 
 
 

When the camera is on, a preview image 
will display if you roll the cursor over the 
tiny thumbnail next to the camera button. 
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e. Perform an audio test by speaking into the mic:  
You should see a fluctuating green-to-yellow bar under the Audio Input slider.  
     - If the color under the slider is orange-to-red, slide the volume control to the left  
        to lower the volume. 
 
 
 
 
 
 
 
     - If you do not see any fluctuating color under the Audio Input slider: 
                 1.  Check that your mic is plugged in.  
                 2.  Confirm in the audio pop-out menu that your mic is selected. 
                 3.  If audio input is still not registering, open your computer’s  
                      system Control Panel and go to Sound > Recording and select your mic. 

Make and Save the recording 
1. Start Recording: 

When you are ready to begin recording, click the large, red rec button (or hotkey F9).  
 
TIP: Count to 5 before you start to speak or navigate around the screen; this will avoid clipping off 
the beginning of your presentation. 
 

2. Pause, Resume & Stop Recording: 
You can use the controller, or you can use keyboard 
commands, to pause, resume, or stop recording:  

- To pause recording click the Pause button (or F9).   
- To resume recording, click the Resume button (or F9 again).  
- To stop recording, click the Stop button (or F10). 

If you don't see the recording controller, you can click the Camtasia Recorder icon              
in the Windows Taskbar. 
When you have finished recording, click the Stop button on the recording controller (or hotkey F10). 
Camtasia Studio will generate a preview of the screencast in the Camtasia Recorder Preview 
window. 
 

3. Preview and Save: 
Under the preview window is a playback 
controller, and buttons to save or delete the 
recording. You can produce the recording straight 
to a shareable format, but we recommend instead 
that you save the recording so that it can be edited 
in Camtasia Studio. 

Audio Input Test 
When you speak, you should 
see a fluctuating green bar 
here. 

Use the slider to adjust the 
volume 

Click View at 100% to preview the full resolution 
quality of your video. 

Click Shrink to Fit to fit the entire recording in 
the preview window (display quality may suffer in 
the Preview, but the recorder should look fine). 
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Click Save & Edit. A Save dialog box will open. 

4. Name and Locate the Recording File: 
Choose a filename and a location to save the recording.  

By default, files will be saved in My Documents in the Camtasia Studio folder (or the last location 
where you saved Camtasia files).  You can change the location, but regardless, we suggest you 
create a new folder in which to store the files for each screencasting project.   

Click Save. The file will have a .camrec extension (e.g., myscreecast.camrec), and Camtasia Studio 
will open in Camtasia with the screen capture, audio, and web cam video (if you recorded it) each in 
it’s own track on the timeline.  
Note: If you used the Webcam feature, the video will appear to bottom-right of the screen recording. 
You can change the position of the Web cam video later. 

 

5. Choose a Size for the Produced Video: 
In the Camtasia Studio Task Bar (at top), click the Dimensions button to open the Editing 
Dimensions dialog.  

 
From the Dimensions drop-down, select the size for 
your produced video: 

•  A good choice for hosting on YouTube or other  
   online services is 720p HD. 

•  For embedding on a course web site, smaller  
    dimensions may be better, for instance 480p SD if  
    your recording area had Wide dimensions (16:9  
    aspect ratio), or a Custom setting of 640 x 480  
    when the recorded area is Standard (4:3 aspect  
    ratio). 
 
Click OK.  
 
 

 

6. Save the Project File: 
Go to File  > Save Project to save the project as an editable .camproj file. 
 

To learn how to edit and produce your project, see Edit Your Recording, below. 
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Record with the Camtasia PowerPoint Add-In 
TIP: The PowerPoint Add-In is only useful if your entire presentation takes place within PowerPoint.  
If your presentation includes links to Web pages or other applications, use the Record Screen method. 

Prepare PowerPoint Presentations for Screencasting 

Visual Design for Screencasting 
Screencasts of PowerPoint will be improved by facilitating the readability of your PowerPoint slides: 

 

PowerPoint features that Camtasia can use 

• Presenter Notes for PowerPoint slides can be imported into your screencasts as captions. 
Importing notes improves accessibility for all audiences. 

• Slide Titles can be used by Camtasia to create a table of contents for your screencast.  

Recording the Presentation 
You may wish to print out notes or an outline for your PowerPoint slideshow in preparation for recording 
a screencast of your slides.  If you have two screens, or are attached to a projector, you can use 
PowerPoint in Presentation mode to be able to read your notes and record the projection/2nd screen. 

1. Close Camtasia, if open. This will ensure you start a new project. 

2. Launch PowerPoint.  Note: The first time you use PowerPoint with the Camtasia Add-In enabled, 
you will see a welcome screen and screencast on getting started with the Add-In. On subsequent uses 
this screen will not appear. 

You can also initiate a Camtasia PowerPoint recording from the Camtasia Studio Welcome screen, or 
from a new Camtasia project, in which case PowerPoint will launch and ask you to locate your 
PowerPoint presentation file. 

3.   In PowerPoint, click the Add-Ins tab. 
  
  
  
   
  
A series of recording buttons for Camtasia should appears at the left side of the PowerPoint ribbon. 

4. Click the Recording Options button. For Audio Source, select your mic. Perform a sound check by 
speaking into your mic. You should see a fluctuating green bar. Adjust the volume as needed (the 
colored bar should stay in the green-to-yellow range, and should not go into the orange-to-red range).   

• Use large type (32pt for example).  
Your screencast movie will be much smaller than 
the full screen presentation. 

• Use Sans serif fonts. (Arial, Verdana, Tahoma, etc.) 

• Use high contrast text and background combination 

• Use a simple backgrounds with minimal 
texture (this will also reduce file sizes) 

• Minimize use of slide transitions 

 

Add-Ins Tab 

Recording options 
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Troubleshooting: If audio does not register, go to your System Control Panels, and to the Sound 
settings and confirm your Mic is selected for audio input.  

To capture both microphone and system audio when your presentation includes embedded audio 
or video, on the Add-Ins tab under Recording Options, check Record System Audio.  
Note: Some soundcards may not accommodate recording both mic and system audio.  For a 
troubleshooting guide see: http:/www.techsmith.com/learn/camtasia/6/faq/system-audio.asp 

To record video from a Web cam, under Picture in Picture check Record from camera. 
 
Important: Click OK before leaving the Recording Options window. 
 

5. Click Record.   
  
PowerPoint will launch in presentation mode, overlaid by a box saying 
Camtasia Recording is paused. You have one more chance for a sound-
check here. 

6. Click Click to Begin Recording. 

If you are recording on a large screen, you may see a warning: 

 

Because PowerPoint presentation mode is full-screened, it commands a lot of computing resources to 
record.  Click Close to close the warning and attempt to record your presentation.  If your computer 
is performing poorly, follow the suggestions in the onscreen tip to improve performance.  

7. Advance through the PowerPoint slides as normal, narrating into the microphone. 
 
•  To pause/resume recording: press CNTRL + SHIFT + F9 on your keyboard.  
•  To exit the presentation and stop recording: press the ESC key (or CNTRL + SHIFT F10).  
    Or, at the end of the presentation, Camtasia will give you the option to Stop recording. 

8. You will be prompted to choose a filename and a location to save your recording as a .camrec file. 

9. Choose to either Edit in Camtasia, or Publish without editing. 

When you choose Edit, Camtasia will ask if you wish to Include Notes. If you have included notes 
in your presentation file, they will be used for closed-captioning. When editing, you can setup the 
captions to appear only if the user clicks a CC button (see Editing section of this handout). 
Note: Closed-captioning is recommended for universal access to course materials (see tips below for 
Closed Caption controls) 
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After choosing Edit, the video will open in the Camtasia Studio Editor, with the screen capture, 
audio, and if you recorded it, Web Cam video--each in their own tracks on the timeline. 
 

10. In the Camtasia Studio Task Bar (at top), click the Dimensions button to open the Editing 
Dimensions dialog.  
 

 
 
Pop-out the Dimensions drop down to select a size for your 
produced video.  Because PowerPoints have a Standard 
aspect ratio, you may wish to  

•  A good choice for hosting on YouTube or other  
   online services is 720p HD. 

•  To match PowerPoint’s Standard (4:3 aspect   
    ratio), choose a Custom setting of 640 x 480,  
    or 1024 x 768. 

 
Click OK. Next, you’ll edit and produce your project. 
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Edit Your Recording in Camtasia Studio 
Why edit? At minimum, you may want to trim off noise at the beginning and end of your screencast. 
Camtasia Studio also lets you combine recordings, overdub audio, add titles, and create effects such as 
transitions between segments. 

The Editing Interface  
After recording, if you choose to Edit, or if you open a .camrec, or .camproj file from your desktop, 
you’ll be taken to Camtasia Studio, where you can edit and produce your recording. Once an editing 
project is underway, save a working copy as a .camproj file. When you are finished editing, you’ll export 
a sharable movie file to post online or burn to a CD. 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
Note: Editing material on the timeline, does not affect corresponding clips in the bin. Clips in the Clip 
Bin retain the original recording. If you need to start over you can highlight and delete everything from 
the timeline, then drag a new instance of your recording onto the timeline. 

Timeline & Tracks  
On the timeline you can cut recordings into clips, 
delete sections, rearrange sections, and control when 
to add effects. 
Each kind of content (audio, video, call outs, captions, 
markers, transitions, etc.) is on its own horizontal track 
in the timeline. 

Preview window 
Shows a preview of your screencast. 

Workflow steps 
 Record, Import, Produce. 
 

Task tabs &  
Editing options 
Click the tabs below to select a task.   
This area will display the options 
available for each task.  
 

Preview controller 
 

Playhead & In and out points 
• Gray, center slider shows location in movie. 
• Green, left slider marks in point, and red, right 

marker marks out point. 
• Highlighted blue area between markers is 

selected to edit (cut, copy, process audio, etc.). 

PowerPoint notes, imported as 
Captions make your video accessible. 
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Different Ways to Open Files for Editing 

Immediately after recording… 
1. When you choose to edit at the end of a recording session, Camtasia Studio your recording will 

be automatically placed in the timeline. 

2. Save the project as a .camproj. 
 

Import a saved .trec (or .camrec) file 
You can add a saved .trec recording (or .camrec recording file, the legacy file format from previous 
version of Camtasia Studio) to a new project: 

1. Launch Camtasia, skip past the Welcome screen, and go to File > New Project. 

2. Click the Import Media button on the Workflow bar (at top) and select the .camrec file. The 
recording will appear in the Clip bin. (Or just drag the recording file from your Desktop window 
into the Bin in Camtasia.) 

3. Drag the thumbnail for the recording from the Bin onto the Timeline. 

4. Save the project as a .camproj. 
 

Open a saved .camproj Project 
To work on a project you have already saved, double-click on a .camproj file from the desktop, or launch 
Camtasia, skip past the Welcome screen, and go to File > Open Project. 

 

IMPORTANT!  For each project, keep .camrec and .camproj files in the same folder. 
In order for a .camproj file to open, the .camrec file must be present along with any other media files 
you'll include in your production (such as background audio or still images). 

If you make a copy or move a .camproj file out of it's folder without also copying the .trec(s) to the same 
place, you will not be able to open the project for editing. 

Note: Your final product will be a .mp4, or other sharable movie file, and cannot be edited in Camtasia. 
To make changes to a movie you must reopen the .camproj project, then export (produce) the movie 
again.  
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Basic Editing 

Playback Your Video 
Use the Preview Controller to play the recording. 
 

 
 
 
To fine-tune the playhead location, use the frame-by-frame buttons on the controller, or keyboard 
hotkeys: 

     •  SPACEBAR -  play and pause playback.  
     •  CNTRL + RIGHT ARROW - forward one frame  
     •  CNTRL + LEFT ARROW - back one frame 
 

Insert Markers 
Before you make edits to a recording, it can be helpful to play  
through the video and mark locations on the timeline where 
you will make a cut, adjust the audio, insert a title slide, etc.  
Markers can also used to create a Table of Contents in your 
produced video. 

Note: When you record with the PowerPoint add-in, Camtasia 
automatically adds a marker between each slide. 

1. When the Preview playhead reaches a frame where you 
will make an edit, press M to insert a Marker in the 
timeline. A small green pointer will appear above the Time ruler.  
If the Marker track is showing, a thumbnail of the frame appears in the Marker track. 

2. Enter a short but informative name for the marker. 
3. Click on a Marker in the Timeline to move the playhead to that location, and then make your edit.  

 

Trim off the beginning or end of a recording 
 Here’s a convenient method for removing unwanted frames from the beginning or end of a recording:  

1. Hover the mouse over the very beginning or end of a track: you 
should see a double-arrow cursor.  <—> 

2. To trim the beginning of the recording, hold down the mouse 
button and drag the cursor to the right. To trim the end, drag to 
the left. 

3. When you release the mouse, the material before the cursor (if 
editing the beginning of the recording) or after the cursor (if 
editing the end of the recording), will be removed. 

4. If there is more than one track in your recording, for example if you recorded system audio, be sure 
the also trim other tracks to match so that everything stays in sync. As you trim each subsequent 
track, an orange vertical line indicates you have matched the previous trim. 

Preview Playhead location 
 

Frame-by-frame playback 
 

Rewind 
 

Timeline Marker 
 

Play / Pause 

Hide/show 
Marker track 
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5. When trimming off the beginning of a recording, for each track, right-click on the track name (at 
left) and choose Select all media on track, then drag the highlighted media to the left, to the 
beginning of the timeline. 
 

Select a section of the timeline to edit 
1. Click in the Time Ruler, or on a Marker where you want the selection  

to begin. The playhead will relocate. 
2. Drag the Out point slider through the Time Ruler, releasing where you 

want the selection to end. (It will snap to Markers) 
The area between the green In point and the Red Out point will be 
highlighted blue indicating all tracks under the highlighted area are 
selected. 

3. To fine-tune your selection, drag the In or Out markers. 
4. You can now edit the selection: 

     • Cut            - Cut deletes the content from all tracks, snaps them closed  
        to remove the gap, and "stiches" the cut so that you can apply effects to the segment in one       
        command. To unstitch the cut, right-click on the zippered cut line and select Unstitch. 
     • Edit audio - See Edit Audio, below to adjust volume, insert silence, etc. in the selected area. 
     • Zoom - To zoom in on the selected area, see Smart Focus, below. 

5. To deselect a  selection, double-click the gray Playhead.  
 

Split a clip into segments 
Splitting a clip lets you to add transitions between segments, or delete a segment of a track.   

1.  Click in the Time Ruler, or on a Marker, at the top of the timeline, or use the 
Preview controller to move the play head to the spot where you wish to make a 
division.  

2. In the toolbar above the timeline, click the Split button, or press S on the 
keyboard.  
 
Once the split is made, you'll see a vertical line across all the tracks in the timeline. 

Note: If you split the timeline while a selection is made, the split will be made at the Out point. 
 

Delete a segment from the timeline 
Once a recording is split into segments, you can delete sections of a track.  

Use this method carefully, as it affects only one track at a time. (See Cut (above) to remove selected 
footage from all tracks from a section of the timeline). 

Right-click on the segment of a track that you want to delete and choose Remove From Timeline.  
(Audio for that clip will also be removed if audio and video are combined.) 
 
 
 
 
 

In point 
 

Selected footage 
Is highlighted blue 

Out point 
 

Split button 
 

Double-click to deselect 
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Add transitions  
You can only apply transitions between clips, and if a clip is too 
short, you won't be able to apply a transition.  
1. If needed, split the track (see above), where you wish to apply 

the transition.  
2. Click the Transitions tab. (If the tab doesn’t show, click the 

More tab and choose Transitions.) The Transitions panel will 
open. 

3. Drag-and-drop the icon for a transition style onto the split (or 
beginning or end) of a track.  A turquoise block representing 
the transition appears on the track. 

4. To adjust the duration of the transition, drag the sides of the 
turquoise block on the timeline. 

Use a Callout to add titles to your presentation  
To add an opening or closing title, or a title between segments:  

1. For an opening title, select everything on the timeline (CNTRL + A) and slide it to the right to make 
room for an opening title slide. 

2. Move the playhead to the point where you wish to add a title.  
3. Click the Callouts tab. The Callouts panel opens. 
4. In the Callouts panel, click the Shapes 

drop-down, then click a shape with text. 
(Simple Rectangle works well for full-
screen titles.)  
The screen will change to show a text 
editor in the Callout panel, and a preview 
of in the Preview area.   

5. In the preview area, click and drag the 
shape to reposition, or drag from its edges 
to resize the box, for example, if you want 
it to cover the entire screen.   

6. Choose a fill color for the box (at left, 
under Shape, in the Callout panel). 

7. In the entry box (at left), enter your text. A preview of the text box will show in the Preview Window 
(at right). 

8. Format the text size, font, alignment, and color as needed.  
9. Adjust the duration of the clip on the timeline by dragging its beginning or end. 
Note Callouts will sit on their own track above your video and audio tracks.   

Use an image in a title clip: 
1. Click the Import Media button above the Media Bin, and choose and import an image file to your 

project. A thumbnail of the imported image will appear in the Media Bin.   
2. Drag the thumbnail icon onto the top (empty) track of the timeline.    
3. To add text over the image add a callout (as described above) and make the fill color for the box  

No fill. 

Type here 
 

Choose shape 

Choose 
fill color  

Adjust duration, add transitions 

Preview Window: 
resize and 
position the shape 
here 



Screencasting with Camtasia Studio 8 

 
UMass Amherst IT, Academic Computing        http:/it.umass.edu/instruct           150624 mt 
 

16 

Apply and Edit SmartFocus 
While you are recording the screen, Camtasia tracks the location of every mouse click and keyboard 
entry. When SmartFocus is applied to a clip on the timeline in Camtasia Studio, the movie will zoom in 
to wherever mouse or keyboard activity was tracked.  

SmartFocus can make menus and text entry boxes or details of an image easier to see, but too much 
zooming and panning will make your audience sea sick! 

Note: SmartFocus can only be applied when the recorded video is larger in dimensions than the 
produced video. 

1. Click the Zoom-n-Pan tab. If the tab doesn’t show, click the More tab and choose Zoom-n-Pan. 
2. To apply SmartFocus to the entire timeline, click Apply SmartFocus to Timeline. 

To apply SmartFocus to just a segment of the timeline, make splits (see above), then click Apply 
SmartFocus to Clip.  

3. To fine-tune the position of the zoom area, the magnification of the zoom, or it’s duration,  
click on a zoom-n-pan key frame in the timeline.  You can then reposition or resize the zoom box in  
the preview in the Zoom-n-Pan tab.  You can also edit values for duration of the zoom. 
 

Remove SmartFocus from timeline 
If SmartFocus or Cursor animations were added automatically to your project when 
you brought the recording into Camtasia Studio, and you do not want them, you can 
remove them all at once. 

1. Make sure you can see the Animation view.  Click the small  
triangular icon under the recording track, if needed.  

2. Right-click on any blue animation bubble, and choose  
Delete all visual animations on media.  
 
 

Edit Audio 
1. Click the Audio tab. (If the tab doesn’t show, click the More tab and choose Audio.)  
2. The Audio options will appear.  

Selected media properties (volume leveling and 
noise removal) are applied to the entire timeline.  
Editing tools are applied to a selected segment of an 
audio track.  

3. To use the Editing tools, you must first select the 
segment in the timeline. 
Note: It is helpful to zoom in on the timeline to 
accurately position the In and Out sliders for the 
selected section of an audio track. 
Editing tool options include increasing & decreasing 
volume, and fading in and out (useful to ease in or 
out a music track, for instance at the beginning or 
end of a project). Silence can be used to remove 
audio from a section of the timeline without 
removing the corresponding screen recording. 

Right-click blue bubble 
for context menu 

 

Click to open 
animation tray 
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4. To add an additional track of audio for background music or overdubbing, use the Import Media 
button at the top of the editing screen. Drag the media clip onto the timeline, a second audio track 
will automatically appear. 

 

Caption your Narrative 
It will save you time and trouble to wait and make adding captions the last step before publishing your 
production. 

Open the Caption panel to edit the text in imported captions, 
adjust the timing, or compose captions from scratch. 

Import Captions from PowerPoint 
If you used the PowerPoint add-in and included Notes, the note 
text can be automatically added as captions.   

Use Speech-Recognition to Create Captions 
Camtasia also provides speech recognition technology to 
automatically create captions from an audio track.  This can save 
time, but expect to do some text editing. 
 
TIP: Train your computer to understand your voice! Until you do, 
you may get surprising results. For more help with captioning in 
Camtasia search the Learning Center help pages at 
techsmith.com. 

Onscreen or closed Captions? 

Depending on the setting you chose for producing your video, you may be able to use Open Captions, 
where the caption text always shows at the bottom of your slides your slides, or Closed Captioning, 
where users can click a CC controller in the movie’s controller to make the captions appear (See Share 
your Screencast, below): 

 

 
 
Save the project file 
1. Go to File > Save.   
2. Choose a filename and a location to save the file.  The file will have a .camproj extension.  Return to 

the .camproj file for further editing as needed. 
 
 

Combine recordings in a project 
You can add a Camtasia recording, an audio recording, or a video recording to a Camtasia Project. For 
example, for creating tutorials, some people like to record and edit their narrative first, then "perform" 
the screen action to the finished audio while it plays back in another application (such as Audacity). 

1.  Click Import Media (at top) and browse for the TREC, MP3 or other allowable file type.   

2.  The recording will appear as a clip in your projects Media Bin.  Drag the clip onto the timeline.  
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Produce Your Screencast in a Sharable Format 
The export or publishing process, called producing in Camtasia Studio, assembles your screen recording, 
narration, and effects into a final product that can be delivered to your students.  

1. Select an action from the Produce & Share menu: 
  

  
 
 
 
 
 
 
You can publish directly to the Screencast.com, Google Drive (including Apps at UMass Amherst) 
or YouTube services, in which case no local files will be saved to your computer and your sharable 
files will be only be stored online. 
 

2. Choose Produce and share… to save your sharable files to your computer and then upload the 
movie to your Moodle course or iTunesU course, or insert your video in an iBook, etc. 
• To produce a video with closed captioning (if the Camtasia project has a caption track), or a 

table of contents if your project has named Markers, choose MP4 – with Smart Player (there 
are several different sizes: from 480p to 1080p).  
 
This option produces a set of files so that your movie plays on a Web page. You must host these 
files on Moodle or another site that will serve a Web page (HTML file). Note: Neither Google 
Drive nor Box will serve an HTML file). 

• For more control over which features to include: 
Choose Custom production settings. This will allow you to select which markers to include in 
your Table of Contents, what “skin” to use for your player controller, whether captions show as 
Closed Captions, burned in, or under screen. (Keep clicking next, and explore the tabs in the 
wizard to select features.) 
 
This option also produces a set of files that you can host on Moodle or another site that will serve 
a Web page (HTML file).  Note: Google Drive will not serve an HTML file). 
 

• If you will upload your screencast to an online video service such as Vimeo, iTunesU, or 
Google Drive, Box or use it in an iBook or other E-book format that allows video: 
Choose MP4 only (there are several different sizes: from 480p to 1080p).   
 
This option produces a single MP4 file.  It will show captions (if there is a caption track) as 
Open captions (always on) and cannot include a Table of Contents. 
 

3. Click Next, and choose a location to save the file(s). 
 
Click Finish. Camtasia Studio will begin to “render” the final product. Note: The rendering 
process can be slow it may take as long as the video, depending on your computer.   
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Share Your Screencast  

Host a Screencast in Moodle 
If you produced a folder of files using the MP4 – Smart Player or Custom options, add a File to your 
Moodle course page: 

1. To preserve the file hierarchy produced by Camtasia, zip (compress) the folder. On your Windows 
desktop, right-click on the folder and choose Send to > Compressed folder (.zip). 

2. In your Moodle course, click Turn editing on and choose Add a Resource or Activity, then Add a 
File.  

3. Drag and drop the .zip file into the Moodle Add a file area, then right-click and choose Unzip. 
4. Important: Once the files are uploaded (and unzipped), click the Action icon for the .htm or .html 

file in the folder, and select Set main file. (This will make Moodle open the .html (web page) with 
the embedded movie when your students click the File link on your Course page.) 

5. Important: For Display, select Open. (Do not use the default setting of Forced download.) 
6. Save and return to course page, then test your link to ensure it is working correctly. 

  
 If you produced a single video file using the MP4 only option, add a Page to your course page: 

1. In your Moodle course click Turn editing on and choose Add a Resource or Activity, then Add a 
Page. 

2. In the Editor bar, click the Insert Video button, then upload the MP4 file. Moodle will embed the 
video in the page. 

3. Save and return to course page, then test your link to ensure it is working correctly. 

Host a Screencast on Google Drive 
To share a screencast from your Google Drive (on Apps at UMass Amherst, or google.com) produce a 
single MP4. 

1. Upload the MP4 file to your Google Drive.  
2. Right-click the file name and select Share. The Sharing settings dialog will open. 
3. For Who has access, click Change. The visibility options will open. 
4. Choose a permission level, such as Anyone with link or People at UMass Amherst with the link, 

and click Save. 
5. From the Link to share box, copy the URL.  You can send the link in an email, or use it as a URL 

resource in Moodle.  The video will play in Google Drive. 
NOTE: If you use the Camtasia option to directly Share to Google Drive. The permissions will 
automatically be set to “Anyone with the link.” 
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Appendices 

Production & Publishing Best Practices 

Use the same stylistic conventions for all the videos in a set. 
Use standard practices for each set of movies published on the same Web site or CD (similar title 
screens, closing screens, consistent recording of keyboard sounds, etc.). 

Keep it short & engaging 

Whether you are delivering a lecture or demonstrating software, it can be more effective to 
deliver short 5 to 10 minute videos, or at least a table of contents with bookmarked segments, 
rather than simply posting one 50 minute lecture.  

Considering revising your PowerPoint lectures for the screencast environment. Integrating 
lecture segments with other resources (text book chapters or other readings) and activities (short 
research or response assignments, forum posts, etc.) can make lecture content more engaging. 

Don't use the cursor to direct the eye around the screen. (Sit on your hands!) 

Move the mouse as little as possible.  Instead of waving the mouse around the screen as you 
record, it can be most effective to add annotations, cursor effects, or zoom & pan, when you edit 
the screencast. 

Take a breath, smile and relax! 
Your voice will reflect it. Don't worry about making a mistake. If you do, just pause, take a 
breath,  and step back to a natural break in your narration.  You can easily edit out mistakes later. 
Keep a glass of water nearby.  

If you're not satisfied with your results, consider recording your narration and video separately. 
Either order can work.     

Control file size  
Depending on the contents of your screencast, you might be able to reduce the file size of your 
published movie by using a different Production Setting. You may need to experiment and 
compare. 

On the Web page that links to the movie, or on the title screen, if the video is embedded 
on a page… 

 To help your audience to decide when and where to watch the movie: 

• Use a “video” icon with the link, or preface the link text with “Video:” (e.g., “Video: 
Lecture 1) 

• Indicate the movie length (in minutes). 

• Indicate if the movie has an audio track. Your audience may want to use earphones. 
  

More advice on screencasting 

http://www.mediacore.com/blog/how-to-record-your-screen-and-create-engaging-screencasts 

http://www.smashingmagazine.com/2010/12/09/most-common-mistakes-in-screencasting 

http://thescreencastinghandbook.com/  (open source book) 
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Software and Hosting Alternatives 
 

Recording: 

For short recordings, or recordings that do not require much editing beyond trimming start and end 
footage, you may wish to consider these alternatives to Camtasia. 

Product Website Mac/PC Cost Notes 

Jing www.techsmith.com Both Free 5-minute limit, very easy 

Screenr www.screenr.com Both Free 5-minute limit, very easy 

SnagIt www.techsmith.com Both $ No duration limit, easy 

QuickTime www.apple.com Mac Free Easy, but produces very large files 

Echo 360 
Personal 
Capture 

Contact 
instruct@umass.edu 

Both Free  Easy. Limited editing, but rich 
playback environment 

 

Uploading and Sharing: 

Depending on your audience you may want to host your video in  

Product Website      Notes 

Box https://umass.app.box.com/ • Secure, hosted on UMass servers, 
access can be restricted to specific 
students. 

• Play on Box or embed 
Apps at 
UMass  

http://apps.umass.edu • Hosted on Google Apps for Education, 
access can be restricted to specific 
students. 

• Play on Drive or embed 
Vimeo http://www.vimeo.com • The ‘professional’ alternative to 

YouTube. 
• Free, has privacy options. 
• Play on Vimeo or embed  

YouTube http://www.youtube.com • Very easy to use, student familiarity. 
• Free, has privacy options. 
• Play on YouTube or embed 

Echo 360 http://it.umass.edu/classroom-
technologies/lecture-capture-
umass-amherst 

• Campus-provided hosted service 
• Viewing restricted to UMass 

community   

Moodle it.umass.edu/support/moodle/a-
quick-tour-moodle-instructors 

• Play in a new "Page" in Camtasia's 
player or embed  

• Viewing restricted to course 
members 
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